Testing
automatizado
em Genexus




CONTEUDO

CONTEUDO
OBJETIVO
APLICATIVO
TESTING
TESTES UNITARIOS
GEREMOS UM UNIT TEST A PARTIR DO PROC!
CENARIO 1: Unit Test falha
CENARIO 2: Unit Test aprova
CENARIO 3: Validacdo do estado do banco de dados
TESTE DE INTERFACE
GRAVACAO DE FLUXO COM GXtest Recorder
TEST SUITES (OPCIONAL)
CENARIO 1: Test suite aprova

CENARIO 2: Test suite falha

10

12

12

22

22

23



Neste workshop, vocé tera um guia passo a passo para construir e executar um teste unitario e um
teste de interface de usuario para aplicativos web. O objetivo deste laboratério ndo é treinar, mas
sim familiarizar-se com a simplicidade do uso da ferramenta GXtest para desenvolvedores e
testadores de aplicacbes GeneXus.

APLICATIVO

A aplicagdo com a qual trabalharemos simula ser um Business Courier, utilizado para gerenciar
conténeires com as respectivas caixas, clientes e alfandegas. Vamos ver o aplicativo!

1. Abra o IDE de GeneXus

2. No caso de nao abrir automaticamente, abra a KB chamada de “GXtestHandsOn" (File > Open
> Knowledge Base , selecione de C:\Models\GXtestHandsOn o arquivo GXtestHandsOn.gxw)

3. Execute a partir do IDE de GeneXus (F5). A seguinte tela devera se abrir no seu navegador
Chrome:

Miami Courrier

Recents Home

Boxes

Cities

Containers

Customers

List Prices
4. Clique em “Containers”. Vocé pode ver que o aplicativo possui dois conténeires com suas
respectivas caixas. Observe que o container 1 tem uma quantidade de 9 caixas.

A

[ Miami Courrier

Recents Boxes — Home — Containers

Containers nternal Number

Id Internal Number  Departure Date Arrival Date  Airline Total Boxes

1 00128 09/08/13 09/11/18  Tampa Cargo 9 XML SET COSTS UFDATE D

2 00129 091319 /1 DHL Cargo 5 XML UFDATE D



5. Clique no link “00128" do container de id 1. Vocé pode ver mais informac¢des do container:

A

[ Miami Courrier

Recenis Home — Containers — 00128
Container Information € CONTAINERS
Internal 00128
Number
General Box
Id 1
Internal Number 00128
Departure Date 05/05/21
6. Clique na janela Box. Vocé pode ver na coluna Custo que todas as caixas tém como status
inicial um custo de 0. Quando uma caixa é criada, ela é criada com custo 0.
7"‘ Miami Courrier
Recents Home — Containers — 00128
Container Information € CONTAINERS
Internal 00128
Number
General Box
Tracking Type Weight Status Purchase Amount Cost Is Retained Be Delivered Customer
1146HFGDS3 Clothes 230 AT DESTINATION 180.00 0.00 false Pablo Romero
KJST58TF541 Electronics 0.80 AT DESTINATION 30.00 0.00 false  Analia Gutierrez
290DKJHHXAZ Baby Accs. 1.70 AT DESTINATION 90.00 0.00 false Joaguin Martinez
T343GFDW953 Home decor 3.60 AT DESTINATION 165.00 0.00 false  Sofia Peréz
BCHS837MSM1 Clothes 1.80 AT DESTINATION 130.00 0.00 false Pablo Romero
08KSDX73BD1 Furniture 5.00 AT DESTINATION 180.00 0.00 false  Analia Gutierrez
9BFIEN38328 Cam Lenses 3.00 AT DESTINATION 180.00 0.00 false  Analia Guiierrez
SCYUETBI8796 Stickers 1.00 AT DESTINATION 180.00 0.00 false  Sofia Peréz
SCYUETB298796 Toys 2.00 AT DESTINATION 55.00 0.00 false Joaquin Martinez

A funcionalidade mais importante do aplicativo é Definir o custo das caixas de um container.



TESTING

Vamos validar o correto funcionamento da funcionalidade Definir o custo das caixas de um
container. Ele é implementado no nivel da interface no painel Containers (etapa 4). Ao clicar no
link SET COSTS, é definido o custo das caixas associadas ao container. Ndo clique em SET COSTS, pois
isso alterara o estado do banco de dados do aplicativo.

Em uma primeira instancia, testaremos a funcionalidade Definir o custo das caixas de um
container com um teste unitario, mais conhecido como unit test. Posteriormente, verificaremos a

funcionalidade no nivel da interface, executando um teste de interface de usuario, mais conhecido
como Ul test (user interface test).

TESTES UNITARIOS

Nesta se¢do, o guiaremos para que vocé possa executar trés cenarios diferentes de teste unitario.

A funcionalidade Definir o custo das caixas de um container, é implementada pelo procedimento
"SetCostToBoxesInContainer" do nosso KB. Vamos ver o procedimento!

5. Abra o procedimento clicando com o botdo direito sobre ele e selecionando “Open” ou
simplesmente clicando duas vezes nele.

St Page X

Open: | | Start Learn Samples Marketplace
i LebGXiest A
& ] Main Programs
Root Module
TOP NEWS
GeneXus New N
Common -
Procedures D = e u-‘t Style
:- CreateXmlForCustoms Open Part ’ Holfo Andres Mufioz Palma
::' divide E] Copy CTRL+C lutStyle is a UC that allows
.= GetBoxinfo o Cut CTRL+X b to have data entry tables
:. GetExraCosts i th attractive visual styles. It
:" GetlistPriceCost v1 ¥ Delete SUPR E more than 20 differen...
.= GetlistPriceCost_v2 cave A
°% SetBoxesAsRetzined Ve s
] SetCostToBoxesInContainer References CTRL+F12
.= stringConcatenation l History CTRL+SHIFT+H
-& writeDebug ©| Properties F4
Security 3. Create Unit Test me
Tests

Transactions
eb pGXtest
GiXtest



6. Clique na guia Rules. Vocé pode ver que o procedimento recebe como parametro de
entrada &Containerld (id do container para o qual vai definir o custo das caixas) e retorna o
parametro de saida &ModifiedBoxesCount (nUmero de caixas modificadas):

:' SetCostToBoxesinContainer X

Source | Layout Cenditicns | Variables | Help| Decurmnentation |

1El parm{in:&ContainerId, out:&ModifiedBoxesCount);
2

7. Clique na guia Source. Vocé pode ver, na logica do procedimento, que o proc atribui o custo
de cada caixa de container cujo id corresponde ao parametro de entrada &Containerld:

StartPage X _* SetCostToBaxesinContainer X

Layout| Rules | Conditions | Variables | He|p| Documentation |

1: //Todo: Add EXTRA COSTS adding a new Input variable <AddExtraCosts:Boolean>
2! //BoxCost = GetlistPriceCost_v2(BoxWeight) + getExtraCosts(BoxId)
3: BModifiedBoxesCount = @

4{= for each Box

5 where Containerld = &ContainerId

]

7 BoxCost = GetListPriceCost_wl(Boxdeight)

] &ModifiedBoxesCount += 1

g:L endfor

10: commit

11

GEREMOS UM UNIT TEST A PARTIR DO PROC!

8. Selecione o procedimento “SetCostToBoxesInContainer” no painel KB Explorer, clique com o
botdo direito e escolha a op¢ao “Create Unit Test".

| mM@in rrograms L |

Root Medule | 1 //Todo: Add EXTRA COSTS adding a new Input variable <AddExtraCosts:Boolean>
GeneXus — - v I GetlistPriceCost_v2(BoxWeight) + getExtralosts(BoxId)
Commwon . joxesCount = @
Procedures G Cpen Fi2 lox ) ‘
::. CresteXmlForCustoms Open Part ) |Containerld = &Containerld
o» divide Copy CTRL+C |t = GetListPriceCost_vl(Boxileight)
:- GetBoxInfo X Cut CTRL+X [iedBoxesCount += 1
& GetExtraCosts ]
::- GetlistPriceCost_v1 % Delete SUPR
:- GetlistPriceCost_v2
N et A Pk, Save As...
d A =2
B | SetCosiToBoxesInContainer Ty References CTRL+F12
* S Sting History  CTRL+MAYUSCULAS=H
+ writeDebug Properties F4
Security [ &, Create Unit Test
Tests

Transactions
Web
GXtest

TestingFramework

I X1Q



Aguarde até que se gerem os objetos de teste "SetCostToBoxesinContainerUnitTest",
"SetCostToBoxesIinContainerUnitTestData" e "SetCostToBoxesInContainerUnitTestSDT" que aparecem
juntos no procedimento "SetCostToBoxesInContainer"

::- SetCostToBoxesinContainer
P, SetCostToBoxesInContainerUnitTest
‘E SetCostToBoxesInContainerUnitTestData
rr SetCostToBoxesInContainerUnitTestSDT

Como pode observar, GXtest gera automaticamente um template de cédigo GeneXus iterando
sobre o Data Provider “SetCostToBoxesInContainerUnitTestData", ao qual contém os conjuntos de
dados que o teste executara.

B SetCostToBoxesInContainerUnitTest X

_5-’3\.:| Rules | Conditions | Variables | Help | Documentation | Patterns
| ]
17 /* Autogenerated unit test code for Procedure 'SetCostToBoxesInContainer' #/
2
3iE For &TestCaseData in SetCostToBoxesInContainerUnitTestData()
4
5 /* act... =/
& &TestCaseData.ModifiedBoxesCount = SetCostToBoxesInContainer(&TestCaselata.ContainerId)
7
8 /* Assert... =
g AssertNumericEquals(&TestlaseData.ExpectedModifiedBoxesCount, &TestCaseData.modifiedBoxesCount, format(!'%1.ExpectedModifiedBoxesCol
10i L endfor
11

Executaremos trés cenarios diferentes: falha no unit test, aprovacdo no unit test e valida¢do do
banco de dados no unit test. Primeiro, inserimos casos de teste incorretos para mostrar o que
acontece quando um teste falha. No segundo, usaremos os valores corretos para obter a execucdo
bem-sucedida do teste. Por ultimo, no terceiro cenario, adicionaremos o teste unitario em uma
valida¢ao de estado do banco de dados.

CENARIO 1: Unit Test falha

9. Clique com o botdo direito do mouse no objeto “SetCostToBoxesInContainerUnitTestData" y
selecione “Open"

itToBoxesInContainerUnitTest X > Delete SUPR
= Indent
.ayout| Rules | Conditions | Variables | Help| Documentation | |i reen
[£ Unindent
e | Al Make Uppercase CTRL+MAYUSCULAS+U |
El/* Autogenerated unit test code for Procedure 'SetCostToB al Make Lowercase CTRL+MAYUSCULAS+L
[l For &TestCaseData in[5et'CostToBoxesInContainer‘Uni‘tTestDat ) i
= Comment Selection CTRL+Q
/* Act... *f £  Uncomment Selection CTRL+MAYUSCULAS+Q
&TestlaseData.ModifiedBoxesCount = SetCostToBoxesInCol 1= (Collapse All
1= EBxpand All
/* Assert... * = pan
AssertNumericEquals(&TestCaseData.ExpectedModifiedBox [~] Toggle Bookmark CTRL+B [a:
endfor D Open F12
Cpen Part 2
Save As...




10. Insira os dados de teste para o caso de teste. Carregue o valor de Containerld =1 e
ExpectedModifiedBoxesCount = 8 e MsgModifiedBoxesCount = '8'.

O codigo do Data Provider é:

SetCostToBoxesInContainerUnitTestSDT

{
TestCaseld ="'1"
Containerld = 1
ExpectedModifiedBoxesCount = 8
MsgModifiedBoxesCount ='8'

}

11. Salve as alteragdes, clique com o botdo direito no unit test e selecione a opc¢do “Run This
Test".

:\- SetCostToBoxesInContainer History CTRL+MAYUSCULAS+H

& SetCostToBoxesInContainerUnit] [@] Properties F4
P SetCostToBoxesInCentainerUnit]
SetT oBoxesInContainerUnitTest

::- stnngloncatenation

- writeDebug
[ Security
[ Tests —
[ Transactions

Ao concluir a execucdo do teste, os resultados serdo exibidos no painel Tests Results.

Start: 5/5/2021 3:43:44 PM End: 15:48:45 Hlapsed: 1 secs Execution detail
Number of tests ran: 1 Q SetCost ToBoxesInContainerlnit Test Coverage
o 0 o 1@ 0 Y] @ 0 Start: Wednesday, May 5, 2021 3:48:44 PM

Elapsed time: 453 ms
Execution results

Expected Obtained Info

Elo - 3 1 ExpectediodfiedBo.. -

o



CENARIO 2: Unit Test aprova

12. Modifique os valores do Data Provider, modifique ExpectedModifiedBoxesCount =9 e
MsgModifiedBoxesCount ='9'".

O cédigo do Data Provider é:

SetCostToBoxesInContainerUnitTestSDT

{
TestCaseld ="1"
Containerld = 1
ExpectedModifiedBoxesCount = 9
MsgModifiedBoxesCount ='9'

}

13. Salve as alteraces, clique com o botdo direito sobre ele e selecione a opgcao “Run This Test".

Veremos que agora o teste nao falhou, o teste passou pois o valor esperado € igual ao
obtido:

Start: 5/5/2021 5:16:46 PM End: 17:16:47 Hapsed: 1 secs Execution detail
Mumber of tests ran: 1 a SetCost ToBoxesinContainerUnit Test Coverage:
a 1 g o@o Ao @ 1] Start: Wednesday, May 5, 2021 5:16:46 PM

Elapszed time: 303 ms
Execution results

SetCost ToBoxesinCortainerlnit Test (303 ms) Expected Obtained Info

(m [VE 9 1 ExpectedModfiedBox.. -

oo s g




CENARIO 3: Validac¢do do estado do banco de dados

Agora vamos validar que quando o proc é exercido, 0 banco de dados realmente muda de estado. Para
isso, adicionaremos uma validagéo (assertion) sobre o estado do banco de dados. Neste caso, a
validacao ira verificar se o custo de cada caixa do container tem um valor maior que 0.

14. Abra o objeto SetCostToBoxesInContainerUnitTest.

Upen: | | Source | Rules | Variables | Help| Docume
"2 LabGXtest ;
&) Main Programs ‘ 1 SetCostToBoxesInContaine
2o d
Root Module [ y rld =1
GeneXus i F4
ModifiedBox:
Commen [ open iz ModifiedBox:
Procedures Open Part L4
% CreateXmlForCustoms Copy CTRL+C
ok divide X cut CTRL+X
% GetBoxInfo =
:,- GetExtraCosts X Delete SUPR
.= GeltlistPriceCost_v1
“% GetlistPriceCost_v2 T
"% SetBoxes/sRetained % References CTRL+F12
& SetCostToBoxesInContainer History CTRL+SHIFT+H
- SetCostToBoxesInContainerUnitTest ©| Properties F4

E SetCostToBoxesInContainerUnitTest ¢

" Record Mocking Data
& SetCostToBoxesInContainerUnitTest .,.

Run This Test

& stringConcatenation

= writeDebug

15. Adicione a seguinte validacdo debaixo do assertion ja existente:

/* Assert del estado de la base de datos. &
for each Box
where Containerld = .Containerld
AssertBoolEquals(true, BoxCost > 0, Format("El costo de la caja %1 del contenedor %2 es %3",BoxId, Containerld, BoxCost))
endfor

16. Salve as alteracdes e execute o test clicando com o botdo direito sobre o objeto Unit Test e
selecionando a op¢ao “Run This Test".

Procedures Open Part b .-
o ela
o= CreateXmlForCustoms Copy CTRL+C
. divide % cut CRL+X | Boy
::- GetBoxInfo = nta:
= £ L tB
:,- GetExtraCosts % Delete SUPR b
.= GetlistPriceCost_v1
“% GetlistPriceCost_v2 Save As.
::. SetBoxes Az Retained % References CTRL+F12
::- SetCostToBoxesInContainer History CTRL+SHIFT+H

.M SetCostToBoxesInContainer UnifTest @) Properties F4

E SetCostToBoxesIinContainerUnitTestl @ Record Mocking Data

r SetCostToBoxesInContainerUnifTest! #‘ Run This Test

::- stringConcatenation
::- writeDebug



No painel de resultados vocé pode ver, na primeira linha, a validacdo do parametro de saida proc e
nas demais as valida¢des do estado do banco de dados do custo de cada caixa

= Tests Results a x
Start: 5/5/2021 6:25:06 PM End: 18:25:07 Hlapsed: 1secs || Execution detail
MNumber of tests ran: 1 o SetCost ToBoxesInContainerUnit Test Coverage:
o 1 e 0 @O0 A0 @ 0 Start: Wednesday, May 5, 2021 6:25:06 PM
Elapsed time: 523 ms
Execution results
----- 0 SetCostToBoxesInContainerUnit Test (323 ms) Expected Chbtained Info
Ko g 1. ExpectedModfiedBoxesCourt: 9 +
O o true true El costo de la caja 1 del contenedor 1 es 48.30 +
O o true true El costo de la caja 2 del contenedor 1es 18.40 +
O ° true true El costo de la caja 3 del contenedor 1 es 37.40 +
O ° true true El costo de la caja 4 del contenedor 1 es 72.00 +
O o true true El costo de la caja 5 del contenedor 1 es 39,60 +
O o true true El costo de la caja 6 del contenedor 1 es 95.00 +
O o true true El costo de la caja 7 del contenedor 1 es 60.00 +
O o true true El costo de la caja 8 del contenedor 1es 22.00 +
O o true true El costo de la caja 9 del contenedor 1 es 42.00 +
Export Clear Results Set as expected

O cédigo final do unit test é:

/* Autogenerated unit test code for Procedure 'SetCostToBoxesInContainer' */

For in SetCostToBoxesInContainerUnitTestData()

/* Act... */

.ModifiedBoxesCount = SetCostToBoxesInContainer(&TestCaseData.Containerld)

/* Assert de la variable de salida del procedimiento )

AssertNumericEquals(
.TestCaseld,

for each Box
where Containerld =

endfor

endfor

.ExpectedModifiedBoxesCount,

.MsgModifiedBoxesCount))

.Containerld
AssertBoolEquals(true, BoxCost > 0, Format("El costo de la caja %1 del contenedor %2 es %3",Boxld, Containerld, BoxCost))

.ModifiedBoxesCount, format(!'%1.ExpectedModifiedBoxesCount: %2',



TESTE DE INTERFACE

Nesta sec¢do, iremos guia-lo para que vocé possa executar um teste de interface do usuario
(doravante, Ul Test) no aplicativo web em que estamos trabalhando. Vamos registrar o seguinte
fluxo: criar uma caixa pertencente ao container 1, definir o custo do container 1, validar que o
custo foi atribuido e excluir a caixa.

Acesse o aplicativo aberto no browser ou clique no botdo "Play" e aguarde até que o aplicativo seja
executado no navegador Chrome novamente:

E LabGXtest - GeneXus Beta
File Edit View Layout Insert Build Knowledge Manager Window Tocls Test Help

B! % ESIS XD = i - Met Environment = | Release =
55 KB Explorer * X 15 SetCostToBoxesinContainerUnitTestData X 5 SetCostToBoxesinCont
Open:| | Layoutl Rules | Conditicns | Variables | He|p| Documentation
"-_L: LabGXiest ~

GRAVACAO DE FLUXO COM GXtest Recorder

Abra a extensao GXtest Recorder clicando no icone da imagem, na extrema direita do navegador:
+ - £

t.NetEnvironment/home.aspx B -

Miami Courrier

1. Clique no botao Start/Stop record :

= GXtest Recorder 4.0.8 = O X

powNLoaD T 1y

2. Quando comega a gravacao, o botdo muda de cor indicando que a gravacao foi iniciada.
= Gltest Recorder 40.8 = O *

GXtest-

pownLoaD (1) by




3. Volte ao navegador e clique na opcdo “Boxes” do menu principal
& Home X +

&« C (@ localhost/LabGXtest.NetEnvironment/home.aspx

Miami Courrier

Recents Home

Cities
Containers

Customers
List Prices

Vocé pode verificar se esta sendo gravado o fluxo ao visualizar as notificagdes que aparecem na
parte inferior da tela. Para cada acao gravada, a seguinte mensagem ¢é exibida:

Command Recorded
command: ClickBy

value:

jle Chrome

4. Clique em “INSERT" para criar uma nova caixa.

-+ INSERT

H Purchase ... Cost Customer Is Retained Container

INATIO 180.00 95.00 Anallla 00128 UPDATE DELETE
Gutierrez



5. Complete apenas os campos Id= 999, Tracking= NEWBOX999, Weight= 1 e Container Id= 1
de caixa e clique no botao “CONFIRM".

Tracking newbox828

Weight

Velumetric Weight

Status RE(

m
[n)]
w

i
m
£
m
=
£

Purchase Amount 0.00

Caost 0.00

Arival Date [zl

Arrival Date ' ]

Delivery Date [zs]

Is Retained

Be Delivered false

Customer Id

Container ld

CONFIRM CANCEL

6. Clique na palmeira para voltar a Home

A

{ Miami Courrier

Recents Home —EBox — Boxes

Boxes Q Irracking

Tracking Type Weight Status Purchase ... Cost



7. Selecione a opg¢ao “Containers” do menu.
@ Home ® +

- l{: (D lacalhasty LabiXtest MetEmarommen

Miami Courrier

Recents Box — Boxes — Home

Boxes
Cilies
Contalners
Custamers

8. Clique em “SET COSTS".

Miami Courrier

3 —Home — Containers

Id Internal Number Departure Date Arrival Date  Airline Total Boxes
1 00128 09/08/19 09/11/19 Tampa Cargo 10 XML UPDATE DELETE
2 00129 09/13/19 /i DHL Cargo 5 XML UPDATE DELETE

A mensagem “Costs assigned successfully” sera exibida indicando que os custos foram
atribuidos corretamente.

Miami Courrier

ents Box — Boxes — Home — Containers

1
41
L

Containers

« Costs assigned successfully

Id Internal Number Departure Date Arrival Date Airline To

1 00128 09/06M13 02/11/11% Tampa Cargo



9. Volte a pagina principal, clique na palmeira.

Miami Courrier

Recents Box —Boxes — Home — Containers

m
]
L

Containers

Id Internal Number Departure Date Arrival Date  Airline Total Boxes

1 00128 09/08/19 09/11/19 Tampa Cargo 10 X

10. Clique em “Boxes” do menu principal.

Miami Courrier

Recents Box — Boxes — Containers — Home

Cities
Caontainers
Customers

List Prices

11. Clique sobre a terceira seta para avancar na lista de caixas.

3.40 INTRANSIT 80.00 0.00 Pablo Romero
3.00 AT DESTINATION 180.00 60.00 Anal?a Gutierrez
1.80 AT DESTINATION 130.00 3960 Pablo Romero

/’

12. Cligue com o botao direito sobre o valor 22,0 para validar, (neste caso o custo da caixa
newbox999), dentro da op¢ao “GXtest recorder” selecione “assertText".

0.00 2¢r e UPDATE DELETE
Atrés
180.00 22( UPDATE DELETE
Volver a cargar
55.00 4210 Guardar como CtrlsS UFPDATE DELETE
Imprimir... Ctrl+P
3000 01 UPDATE DELETE
Transmitir...
88 Crear un cédigo QR para esta pagina
Traducir a espaiol
@ Bloquear elemento.
| > GXtest recorder Jr | assertTent
[El POM Builder - Quick Copy » assertTitle
assertValue
Ver cédigo fuente de pagina
storeText
Inspeccionar ft _
storeTitle
storeValue




13. Clique em “DELETE" e depois clique em “CONFIRM".

Weight  Status Purchase Am... Cost C Is i [+
0.80 AT 30.00 18.40 Analia Gutierrez 00128 UPDATE DELETE
DESTINATION ) o e
1.00 REGISTERED 0.00 22.00 00128 UPDATE DELETE
1.00 AT 180.00 22.00 Sofia Perez 00128 UPDATE DELETE
DESTINATION . 00128 ATE )
2.00 AT 55.00 42.00 Joaquin Martinez 0012¢ UPDATE DELETE
" besTINATION : quin i e nrE :
1.20 IN TRANSIT 30.00 0.00 Pablo Romero 00129 UPDATE DELETE
« <
omer Id o]
ainer Id 1

CONFIRM CANCEL

14. Pare a gravacao pressionando o gravador com o botdo Start/Stop record

% GXtest Recorder 4.0.8 — O

GXtest-

DOWNLOAD (1) ¥

Clique no botdo Play para verificar se o fluxo gravado é realmente o test que desejamos:
%= GXtest Recorder 4,0.8 = O et

GXtest-

powNLoaD T

Agora que verificamos que o fluxo gravado com GXtest Recorder é de fato o teste de
interface que queremos automatizar, vamos importar a gravacdo para a KB.



IMPORTAGCAO DE Ul TEST PARA A KB

15. Clique no botdo “Download” para baixar o cédigo do Ul Test.

" GXtest Recorder 4.0.8 - O bt

GXtest-

DOWNLOAD

16. Abra o arquivo baixado a partir do recorder com o c6digo de Ul Test.

[info] Executing: | AsseriTextBy | id=span_BOXCOST_0001 | 22.00 | -
[info] Executing: | ClickBy | link=DELETE | |

recording (43).bx ~ Mostrar todo X
Vit b

17. Copie o conteudo do arquivo baixado:

j recording (43).txt - Motepad — O
File Edit Format View Help

// Script generated using GXtest Recorder|

//Start webdriver
Rdriver.Start()
Edriver .Maximize()

/ Initial navigation

/
R Go("http://localhost/LabGXtest.NetEnvironment/home.aspx")

&driver.

&driver.ClickBylLinkText("Boxes")
&driver.ClickByID("BTNINSERT™)
&driver. TypeByID("BOXID","999")
&driver.ClickByID("BOXTRACKING™)
driver.TypeByID( "BOXTRACKING™,"NEW BOX 999™)
&driver.ClickByID("BOXWEIGHT™)
&driver. TypeByID( "BOXWEIGHT","1.08")
&driver.ClickByCSS("a.btn.btn-default™)
&driver.ClickByCSS("td.selected.day.today™)
driver.TypeByID( "BOXORIGINARRIVALDATE","@9/13/19")
&driver.ClickByXPath("//div[@id="FORMCONTAINER" ]/div[16]/div/div/div/div")
driver. TypeByID("CONTAINERID","1")
&driver.ClickByID("BTN ENTER™

Ln 34, Col 14 100%  Windows (CRLF) UTF-8




O cddigo gerado é:
// Script generated using GXtest Recorder

//Start webdriver
&driver.Start()
&driver.Maximize()

// Initial navigation
&driver.Go("http://localhost/GXtestHandsOn.NetEnvironment/wwcontainer.aspx")

&driver.ClickByID("IMAGE2_MPAGE")
&driver.ClickByLinkText("Boxes")
&driver.ClickByID("BTNINSERT")
&driver.TypeByID("BOXID","999")
&driver.TypeByID("BOXTRACKING","newbox999")
&driver.TypeByID("BOXWEIGHT","1.00")
&driver.TypeByID("CONTAINERID","1")
&driver.ClickByID("BTN_ENTER")
&driver.ClickByID("IMAGE2_MPAGE")
&driver.ClickByLinkText("Containers")
&driver.ClickByLinkText("SET COSTS")
&driver.ClickByID("IMAGE2_MPAGE")
&driver.ClickByLinkText("Boxes")
&driver.ClickByXPath("(//button[@type='button'])[3]")
AssertStringEquals("22.00", &driver.GetTextByID("span_BOXCOST_0002"),"span_BOXCOST_0002 not matching 22.00")
&driver.ClickByCSS("#span_vDELETE_0002 > a")
&driver.ClickByID("BTN_ENTER")

&driver.End()

18. Crie um objeto Ul Test for Web em sua KB fazendo: File> New> Object, selecione a categoria
“Test”, digite “Ul Test for Web" e pressione “Create”.

MNew Object >
Select a Category: Select a Type:
User Interface a | | T Test Suite
BFM & Ul Test
Chatbots & Unit Test
Resources @ Web Ul Test
@
Documentation
Extensibility
Deploy
Reporting
Test v

Defines a sequence of web User Intefface interactions and validations.

Name: WebUITest1
Description: Web UlTest1
Module/Folder: Root Module -

Create Cancel




19. Cole o conteudo do arquivo baixado de GXtest Recorder.

& SetCostToBoxesInContainerlnitTestSDT X 3%  SetCostToBoxesInContainerUniiTest X ..'q UlTestinebl = X

:| Layout | Rules | Conditichs | Variables | Help | Documentation |
L)
| 7|

1
FINN// Script generated using GXtest Recorder
3
LM/ /Start webdriver
EHS driver. Start()
CHES driver . Maximize()
7
:H// Initial navigation
EHINE driver.Go( "http://localhost/LabGXtest.NetEnvironment/home.aspx™)
10
11 .ClickByLinkText("Boxes")
At driver.ClickByID( "BTNINSERT" )
JRIN driver. TypeByID( "BOXID","999™)
JE R driver.ClickByID( "BOXTRACKING")
SETINC i ver. TypeByID( "BOXTRACKING” , "NEW BOX 393")
IR driver. ClickByID( "BOXWEIGHT" )
VRN driver. TypeByID( "BOXWEIGHT ™, "1.88™ )
18 .ClickByCSS("a.btn.btn-default™)
19 .ClickByCSS("td.selected.day.today")

20. Salve as alteracdes. Clique com o botdo direito no objeto e selecione a opc¢do “Run This Test".

a3
G?th-:st 4 ff5start webdriver
TestingFramework 5] &driver.start()
.T. Domains e wimize()
ey ™ &
7 Refer Open Fi2 navigat
ences| L "http:/
Y Customizati Open Part i
[¥] Documentai Ty Copy Ctrl+C 1ckByID(
. ickByLin
oo Cut CirieX  F ceyID(
4 peByID("
>< Delete Del peByID("
peByID("
Save As... peByID("
1 References CtrlsF12  fCKEVIO(
! 1ckByID(
History Ctrl+Shift+H ickByLin
Team Development p AckByLn
SCKBYID(
€& Properties F4 ickeyLin

& Run This Test .

Se a execucdo falhar, verifique se ndo ha diferencas entre seu cddigo e o da etapa 3.



Em caso de erro, verifique a conexao em Knowledge Base > Team Development > Update:

Mg Team Development X v
Commit | Update | History | Activity | Versions | ontinuous Integration |
Update from Scope
GeneXus Server:  hitp-/'samples genexusserver comivl7 Objects: Al Change...
Knowledge Base:  GXtestHandsOn
Version: GXtestHandsOn Revision: Newest Change...
Last full update:  5/11/2021 5:40:36 PM [T] KB Properties
Pending for Update  |gnored Objects  Results Y Cl}
[m] Name  Type Description Modified On Status Action

Mo pending changes were found

Update

21. Observe os resultados do test quando a execucdo terminar. Vocé pode ver as imagens de
tela do aplicativo durante a execuc¢do de cada comando.

Explore as informacdes / botdes no painel Resultados do teste!

Start: 5/10/2021 6:2%:57 PM End: 18:24:20 Elapsed: 23 secs Execution detail

Number of tests ran: 1 Q WebUITest1 (Chrome 90.0.4430.93)

Q 1 e o@o A0 @ [i] Start: Monday, May 10, 2021 6:23.57 FM

Elapsed time: 23 secs
Execution resutts
WebUITest1 (23 secs ) Step Info Blapsed (ms) -~
@ TypeByID(BOXID,955) 1508 [2A)
@ TypeByIDEOXTRACKI... 1486 [
@ TypeByIDIEOXWEIGH... 1523 [
@ TypeByIDICONTAINER... 1435 [2A
@ CickByIDBTN_ENTER) 1305 [
@ ClickByID(MAGE2_MP... 762 [
@ ClickByLink Text(Contain... 779 [fA
@ CiickByLinkText(SETC... 751 A
@ CickByIDIMAGE2_MP... 791 A
@ ClickByLink Text(Boxes) 281 @
@ ClickByXPath{{//button... 830 [
@ GetTextBylDispan_BOX.. 212 A
0 AgsertStingEquals(22.0...  span_BOXCOST_0002 .. +
@ CickByC5S(Hspan_vD... 920 [N
@ CickByID(BTN_ENTER) 812 [
v
Export Set as expected




TEST SUITES (OPCIONAL)

E possivel agrupar testes criando um objeto de teste Test Suite para que possam ser executados
como uma unidade na ordem especificada.

Existem varias propriedades para configurar o comportamento dos testes dentro do Test Suite,
nesta parte opcional iremos deter no teste da propriedade para continuar ou parar a execucdo dos
testes, em caso de falha.

Vamos implementar um objeto Test Suite onde adicionaremos os testes criados anteriormente!

CENARIO 1: Test suite aprova

1) Crie um objeto Test Suite clicando em File> New> Object, selecione a categoria “Test",
selecione o objeto “Test Suite” e pressione “Create”.
New Object >
Select a Category: Select a Type:
BPM ~ & 2 s N
Chatbots UlTest  Unit Test  Web LIl
Resources Test
Documertation
Extensibility
Deploy
Reporting
Test
ALL v
Creates a new Test Suite”
MName: |Test5u'rte1
Description: |Test Suite 1
Module/Falder: Procedures -
Create Cancel
2) Selecione e arraste do painel KB Explorer o Unit Test e o Web Ul test criados anteriormente e
solte-os no editor Test Suite. Deve ser assim:
fo TestSuitel X + & Properties r X
Documentation | 2| F |F\Iter
Test Continue on error Step: TestSuiteStep
9“& TestSuitel Test SetCostToBoxesInContainerUnitTest
3. SetCostToBoxesInContainerUnitTest .
: WebUTest1 Iterations 1
Continue On Error True

Retries On Error 0



3) Clique com o botdo direito no novo objeto Test Suite e clique em “Run Suite”. Observe que a

execucdo do Test Suite foi bem-sucedida, pois todos os testes do Suite foram aprovados.

& Test Close
Definitig : - i
R Jb TestSuitel X T TestsResults X v
Test Full Screen
=L Test [ Open Start: 5/13/202117:09:32 End- 17:09:33 Hapsed: 6secs Test suite execution details
E' Cpen Part Tests ran: 2 o TestSuitel
b A Start: Thursday, May 13. 2021 5:09:32 PM
:CF: O 2 9 U o 0 Ao Y Elapsed time: 6 secs
o Execution results
>< Delete B__Q TestSuite 1 (6secs ) Summary Count Percentage
Save As... g SetCost ToBoxesInContainerUnit Test (226 ms) 2 100.00 %
B} References €9 WebllTest (5 500s) Total 2 100.00 %
History
Team Development
| Properties
Locate in KB Explorer
G Export
Select Left Side To Compare
pj}_y Run Suite
CENARIO 2: Test suite falha
4) Modifique o objeto SetCostToBoxesinContainerUnitTestSDT com o seguinte cédigo:
SetCostToBoxesInContainerUnitTestS
DT
{
TestCaseld ='1"
Containerld = 1
ExpectedModifiedBoxesCount
=8
MsgModifiedBoxesCount = '8'
}
5) Clique com o botdo direito do mouse no objeto Test Suite e clique em “Run Suite”. O Test Suite
falha quando falha o unit test modificado.
‘= Tests Results X N
Start: 5/13/2021 20:16:05 End: 20:16:09 Hapsed: 4secs Test suite execution details
Tests ran: 2 €3 TestSuiel
O 1 9 1 o 0 ‘1 0 Start: Thursday, May 13, 2021 8:16:05 PM
Bapsed time: 4 secs
Execution results
B--@ TestSuite1 {4 secs ) Summiary Count Percentage
8 SetCost ToBoxesInContainerlnit Test (428 ms) 1 50.00 %
WebUITest1 (3 secs ) Error 1 50.00 %
Tatal 2 100.00 %




6)

= TestsResults X {b TestSuitel X

Test

= Testsuite1
E 3. SetCostToBoxesInContainerUnitTest

.8, WebUTest1

7)

Dentro do painel de edi¢cdo do Suite, clique na coluna Continue on error para o teste
SetCostToBoxesInContainerUnitTest para que nao seja verificado.

Continue on error

[0

Execute o Test Suite novamente. Clique com o botdo direito do mouse no objeto Test Suite e

clique em “Run Suite". Vocé deve obter o seguinte resultado:
:= Tests Results X &: TestSuitel X Mavigation View X N
Start: 5/13/202120:18:52 End: 20:18:52 Hapsed: < 1sec Test suite execution details
Testz an: 1 9 Test Suite 1
Start: Thursday, May 13, 2021 8:18:52 PM
Q0 Q1 Q0 Ao 1 aft. Thursday, Hay
Elapsed time: < 1 sec
Execution results
EI--Q TestSute1 (= 1 sec) Summary Count Percentage
b 9 SetCost ToBoxesInContainerlUnit Test (333 ms) Emor 1 50.00 %
e V
VebUITestT Skipped 1 50.00 %
Total 2 100.00 %

Como pode ser visto, o teste WebUITest1 nao foi executado porque o Test Suite foi configurado

para ndo continuar a execucdo se o teste SetCostToBoxesInContainerUnitTest falhar.
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